
 
   Winter Preparedness 
  Continuous Quality Improvement toolkit 

  
The aim of the Western Sydney Winter Preparedness Toolkit is to equip primary 
care providers with practical resources and strategies to effectively manage, 
support, and improve patients outcome over the winter period in primary care 
settings through a continuous quality improvement (CQI) approach  
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Important 
Information 

 
Toolkit Instructions 

  
Each module includes 
practical, self-directed 

activities designed to help 
primary care providers 

implement sustainable CQI 
practices. 

 

 
Starting Points: 
 

1. Engaged Leadership 
Meet as a team to assign a QI lead and choose a relevant activity from the 
content page above. 
 

2. Data-Driven Improvement 
Use CAT4 data reports to identify target patient cohorts and complete the 
Measuring Outcomes table to track progress. 

 

3. Patient Registration 
Use reminders and recalls engaging patients, support MyMedicare registration, 
and provide education. 

 

4. Team-Based Approach 
Review HealthPathways and complete training if needed. As a team, set SMART 
goals, measures, and change ideas using the Model for Improvement. Test 
small changes using Plan-Do-Study-Act (PDSA) cycles. 

 
Ending Points: Involve staff, complete the Group Reflection table, and celebrate 
success—no matter how small! 
 

Tip – RACGP CPD: Measuring Outcomes 
Collaborate with multiple General Practitioners (GPs), nominate a General Practice (GP) 

lead, and complete at least two PDSA cycles. 
 

 

Why Winter Preparedness is Important?  
Protecting Our Community from COVID-19, Influenza & Pneumococcal Disease 
As winter approaches, a proactive strategy is essential to reduce the impact of COVID-19, Influenza, and pneumococcal 
disease—key drivers of severe illness and hospitalisations, especially in vulnerable populations.  

Primary Care Providers play a vital role in supporting their patients by promoting timely vaccinations and ensuring at-risk 
individuals are protected. 
 
Who’s Most at Risk? 

 

Why It Matters for Western Sydney 
• Higher chronic disease rates increase 

susceptibility to severe infections. 
 

• Flu hospitalisations rose by 30% in 2023, with 
young children & older adults most affected.1 

 

• COVID-19 waves continue to strain hospitals and 
aged care. 

 

• Pneumococcal disease is a leading cause of 
preventable hospital admissions 

 

 

 

  

 
1 https://ncirs.org.au/sites/default/files/2024-10/NCIRS%20Annual%20Immunisation%20Coverage%20Report%202023.pdf  
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https://help.pencs.com.au/display/CG/Getting+Started
https://wentwest.com.au/health-professionals/programs-and-priorities/digital-health/mymedicare/
https://westernsydney.communityhealthpathways.org/
https://wentwest.com.au/health-professionals/general-practice-support/quality-improvement-in-primary-care/
https://wentwest.com.au/wp-content/uploads/2025/02/WentWest-MFI-and-PDSA-Template.dotx
https://ncirs.org.au/sites/default/files/2024-10/NCIRS%20Annual%20Immunisation%20Coverage%20Report%202023.pdf
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For more information, access the NSW Health - Immunisation Toolkit for Immunisation Providers 

Pre-Activity: Immunisation Checklist 
 

By following these steps, healthcare providers can ensure timely vaccine administration, maintain appropriate stock levels, 
and improve immunisation coverage among eligible patients over the winter period. For a comprehensive checklist – refer 
to WentWest General Practice Nurse Support Toolkit -  

Implementation Steps COMPLETED 

Clinicians can access and review HealthPathways the latest vaccination guidelines  

 
 

 

Access and review Australian Immunisation Handbook information.  

 

 

Identify at-risk patients eligible for vaccination programs (Download NSW immunisation schedule) 
 
 
 
 

 

Ensure all staff involved in vaccine management are trained in vaccine cold chain management 
(including receipt of vaccine deliveries) and update any other required training (CPR & First Aid)  

 

Assign roles: Nurse for vaccine administration and monitoring, and reception staff for bookings and 
data entry. 

 

Obtain access to the Australian Immunisation Register (AIR) through PRODA if not already set up and 
link to Practice Management Software 

 
 

 

Service the fridge (if overdue), complete the annual audit, discard expired vaccines, report expired NIP 
vaccines on the State Vaccine Centre portal 

 

Check fridge capacity, calculate required vaccines, order for a 4-week supply, and verify batch numbers 
in the software. 

 

Allocate time over 13 weeks to deliver 960–1,030 vaccinations via onsite (3 clinics/week) and 
fortnightly outreach clinics (i.e. Residential Aged Care Home) 

 

Send communication to all patients, reminding them of vaccination importance and practice 
vaccination arrangements (clinic hours, booking link). 

 
 

 

Advertise via social media, website, in-practice posters, and order printed resources for your clinic. 

 
 
 

 

Send targeted reminders to pre-identified patients and offer opportunistic vaccines during routine 
appointments 

 
 

 

Commence vaccination clinics and track vaccination progress at 30 and 60 days to see if you are 
reaching vaccination target (1000 vaccinations) 

 

Report all vaccinations to the AIR, use the VAE form if required, and notify any adverse events to your 
local public health unit at 1300 066 055. 

 

Review patient uptake with follow-up reminders, reorder vaccines based on stock levels and create a 
waitlist if demand exceeds supply. 

 

COVID-19 Influenza (flu)  Pneumococcal 

COVID-19 Influenza (flu)  Pneumococcal 

Access Module 2 

Access Module 3 

Access Module 3 

Access Module 3 

Access Module 1 

https://www.health.nsw.gov.au/immunisation/Publications/gp-toolkit.pdf
https://wentwest.com.au/wp-content/uploads/2024/11/WW-Practice-Nurse-Support-Program-Workbook_FINAL.pdf
https://westernsydney.communityhealthpathways.org/13454.htm
https://www.health.nsw.gov.au/immunisation/Publications/nsw-immunisation-schedule.pdf
https://aus01.safelinks.protection.outlook.com/?url=https%3A%2F%2Fnswhealth.seertechsolutions.com.au%2Fpublic_content%2FHETICP%2FHETI%2FCCMWebv3%2Fstory.html&data=05%7C02%7Cm.campbell%40cesphn.com.au%7Cfed1b3febdbb440f83a208dd20a2a5ff%7Ce823fe3746da43cd880974cda6b846b4%7C0%7C0%7C638702605151820189%7CUnknown%7CTWFpbGZsb3d8eyJFbXB0eU1hcGkiOnRydWUsIlYiOiIwLjAuMDAwMCIsIlAiOiJXaW4zMiIsIkFOIjoiTWFpbCIsIldUIjoyfQ%3D%3D%7C0%7C%7C%7C&sdata=G1K5Fm0Sv1yK2GFBJbCmqgA%2Be8LoAqzg49Am0fqbRdI%3D&reserved=0
https://www.servicesaustralia.gov.au/organisations/business/services/proda-provider-digital-access
https://www.health.gov.au/sites/default/files/national-vaccine-storage-guidelines-strive-for-5-appendix-2-vaccine-storage-self-audit_0.pdf
https://nsw.tollhealthcare.com/
https://nsw.tollhealthcare.com/
https://www.servicesaustralia.gov.au/proda-provider-digital-access
https://www.health.gov.au/resources/publications/vaccine-administration-error-vae-reporting-form?language=en
https://westernsydney.communityhealthpathways.org/803793.htm
https://westernsydney.communityhealthpathways.org/52701.htm
https://westernsydney.communityhealthpathways.org/310218.htm
https://westernsydney.communityhealthpathways.org/803793.htm
https://westernsydney.communityhealthpathways.org/52701.htm
https://westernsydney.communityhealthpathways.org/310218.htm
https://immunisationhandbook.health.gov.au/contents/vaccine-preventable-diseases/covid-19
https://immunisationhandbook.health.gov.au/contents/vaccine-preventable-diseases/influenza-flu
https://immunisationhandbook.health.gov.au/contents/vaccine-preventable-diseases/pneumococcal-disease
https://immunisationhandbook.health.gov.au/contents/vaccine-preventable-diseases/covid-19
https://immunisationhandbook.health.gov.au/contents/vaccine-preventable-diseases/influenza-flu
https://immunisationhandbook.health.gov.au/contents/vaccine-preventable-diseases/pneumococcal-disease
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Module 1 
 

Understanding your population 
 

On completion of this module, you will: 

• Understand the vaccination needs of your vulnerable population and create an effective register. 
• Use CAT4 to identify vulnerable patients who are due/overdue for immunisation  
• Track vaccination progress at 30 and 60 days to meet vaccination target, estimate stock needs, and enable timely 

reordering. 

Who Should Get Vaccinated 
The National Immunisation Program (NIP) offers free vaccines to eligible individuals including:  

COVID-19 (frequency) Influenza Vaccination (frequency) 

• People aged 65+ years (every 6 months)  
• People aged 18-64 years with severe 

immunocompromise (every 6 months) 
• People aged 18-64 years without severe 

immunocompromise (every 12 months) 
• Children aged 5-17 years with severe 

immunocompromise (every 12 months) 
• Not recommended for children aged under 5 years 

(Annually once per year) 
• Children aged 6 months to 5 years  
• Pregnant women  
• People aged 65+ years  
• Aboriginal and Torres Strait Islander people aged 

6months+ 
• People aged 5+ with chronic conditions e.g., 

asthma, diabetes, heart disease 
 

COVID-19 Booster (frequency) Pneumococcal (frequency) 

• People aged 75+ years (every 6 months) 
• People aged 65-74 years (every 12 months, can 

receive every 6 months) 
• People aged 18-64 years without severe 

immunocompromise (every 12 months) 
• People aged 18-64 years with severe 

immunocompromise (every 12 months, can 
receive every 6 months) 

• People aged 5-17 years with severe 
immunocompromise (every 12 months) 

(Once with a possible booster based on health 
condition)  
• People aged 70+ years 
• Aboriginal and Torres Strait Islander adults aged 

50+ 
• People with chronic medical conditions e.g., heart 

disease, diabetes, cancer, immunocompromised 
individuals 

• Children – refer HealthPathways childhood 
immunisation program  

 
 

For advice about immunisation, phone Immunisation Advice Line 1800-679-477 or  WSLHD Public Health Unit 1300-066-055 
ask to speak to an immunisation nurse. Content accurate as per 25 March 2025. Visit NSW Immunisation Schedule , 
Australian Immunisation Handbook or NSW Health Flu webpage,  Pneumococcal Vaccination Handbook, and COVID-19 
Vaccination Guidelines for latest information.  

Note: when using, considering these filtering options: 

• Removing the "Active (3x 2 years) under ‘Activity’ for new or infrequent patients. 
• Selecting Medicare card holders only (filter: ‘Medicare No’ under ‘Health Cover’). 
• Selecting MyMedicare registered patients 

 

https://www.health.gov.au/resources/publications/national-immunisation-program-schedule?language=en
https://westernsydney.communityhealthpathways.org/45076.htm
https://westernsydney.communityhealthpathways.org/45076.htm
javascript:toggleBlock('107294_d786045e115')
https://www.health.nsw.gov.au/immunisation/Publications/nsw-immunisation-schedule.pdf
https://immunisationhandbook.health.gov.au/contents/vaccine-preventable-diseases/covid-19#recommendations
https://www.health.nsw.gov.au/immunisation/Pages/flu.aspx
https://immunisationhandbook.health.gov.au/resources/publications/pneumococcal-vaccination-for-all-australians
https://www.health.gov.au/our-work/covid-19-vaccines/getting-your-vaccination
https://www.health.gov.au/our-work/covid-19-vaccines/getting-your-vaccination
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1.1 Activity – People aged 65 years and over 

 
CAT4 Recipe:  
Complete the below table by logging into Pen CS CAT4  → Show Extracts → load latest data extract → Hide Extract  
 
 In Filter section 

1. Under ‘General’ tab → ‘Activity’ tab→ select ‘Active (3x in 2yrs)’ OR ‘Patient Status’ tab → tick ‘Registered with 
MyMedicare’ 

 
2. Under ‘General’ tab → Age → Start Age "65" 

 

3.  (optional filtering):  
 Under ‘General’ tab → ‘Ethnicity’ tab → Indigenous Status → select ‘Non-Indigenous’ under  

 

4. Date Range (results) → e.g.  select 12mths –  

NOTE:  Western Sydney HealthPathways Immunisation for vaccine schedule recommendations 

 
 

 

5. Recalculate  
 

  In Report section 
6. “Immunisations” tab → select Influenza or Pneumococcal At Risk or COVID 19 

 

7. Select ‘Not Recorded’ → Export →   XLS File → Save  
(e.g. Create a folder C:/ClinicalAudit/CAT Patient FollowUp) 

  

8. Optional: Create a prompt to display in Topbar  
 

9. Optional: Optional: Use the Measuring Outcomes table to track progress and support self-reflection over time. 

  

Activity goal The aim of this activity is Identify people aged 65 years and over eligible for 
vaccination. 

QI lead & team members      Who will need to be involved? 
Start date  Start date End date  end date 

WentWest provides regular PIPQI reports benchmarking your influenza immunisation rates for patients 65+ 
against other practices in our region. Contact us via support@wentwest.com.au to receive this report.  

https://help.pencs.com.au/display/CG/Navigating+CAT4
https://help.pencs.com.au/pages/viewpage.action?pageId=47317113
https://help.pencs.com.au/display/CG/Ethnicity+Filtering
https://westernsydney.communityhealthpathways.org/44304.htm
https://help.pencs.com.au/display/CR/Using+Topbar+Prompts+in+Recipes
https://help.pencs.com.au/pages/viewpage.action?pageId=47317113
mailto:support@wentwest.com.au
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1.2 Activity – First Nations people 

 

CAT4 Recipe:  

Complete the below table by logging into Pen CS CAT4  → Show Extracts → load latest data extract → Hide Extract  

 In Filter section 
 
1.  ‘General’ tab → Under ‘Activity’→  select ‘Active (3x in 2yrs)’* → or ‘Patient Status’ tab → tick ‘Registered with 

MyMedicare 

 
2. "Ethnicity" tab → Indigenous Status → select "Indigenous" under  

 

3. Date Range (results) → e.g.  select 12mths –  
NOTE:  Western Sydney HealthPathways Immunisation for vaccine schedule recommendations 

 
 
 

4. Recalculate  
 

  In Report section 
5. “Immunisations” tab → select Influenza or Pneumococcal At Risk or COVID 19 

 

6. Select ‘Not Recorded’ → Export →   XLS File → Save  
(e.g. Create a folder C:/ClinicalAudit/CAT Patient FollowUp) 
 

7. Optional: Create a prompt to display in Topbar  
 

1. Optional: Optional: Use the Measuring Outcomes table to track progress and support self-reflection over time.. 
 

  

Activity goal The aim of this activity is identify First Nations people eligible for vaccination. 
QI lead & team members Who will need to be involved? 
Start date  Start date End date  end date 

Use the immunisation period as an opportunity to enrol patients with chronic conditions into MyMedicare 

https://help.pencs.com.au/display/CG/Navigating+CAT4
https://help.pencs.com.au/display/CG/Ethnicity+Filtering
https://westernsydney.communityhealthpathways.org/44304.htm
https://help.pencs.com.au/display/CR/Using+Topbar+Prompts+in+Recipes
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1.3 Activity – Immunocompromised  

 
CAT4 recipe: Complete the below table by logging into Pen CS CAT4  → Show Extracts → load latest data extract → Hide 
Extract  

 In Filter section 
1.  ‘General’ tab → Under ‘Activity’→  select ‘Active (3x in 2yrs)’* → or ‘Patient Status’ tab → tick ‘Registered with 

MyMedicare’

 
2. Conditions tab → Chronic → Kidney Disease → select “Kidney Transplant” 

 

 And/Or Conditions tab → Cancer → “Blood and Immune System” select Yes  

 

And/OR Conditions tab → Other Conditions tab →  STI Conditions tab → select “HIV” 

 
3. Date Range (results) → e.g.  select 12mths  

NOTE:  Western Sydney HealthPathways Immunisation for vaccine schedule recommendations

 
 

4. Recalculate  
 

  In Report section 
5. “Immunisations” tab → select Influenza or Pneumococcal At Risk or COVID 19 

Select ‘Not Recorded’ → Export →   XLS File → Save  
(e.g. Create a folder C:/ClinicalAudit/CAT Patient FollowUp) 
 

6. Optional: Create a prompt to display in Topbar  
 

2. Optional: Optional: Use the Measuring Outcomes table to track progress and support self-reflection over time. 

Activity goal The aim of this activity is identify immunocompromised patients eligible for 
vaccination (i.e. Kidney Transplant, Blood and Immune System Cancer HIV) 

QI lead & team members Who will need to be involved? 
Start date  Start date End date  end date 

https://help.pencs.com.au/display/CG/Navigating+CAT4
https://westernsydney.communityhealthpathways.org/44304.htm
https://westernsydney.communityhealthpathways.org/44304.htm
https://help.pencs.com.au/display/CR/Using+Topbar+Prompts+in+Recipes
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1.4 Activity – Residences of Aged Care Home  

 
CAT4 recipe:  

Complete the below table by logging into Pen CS CAT4  → Show Extracts → load latest data extract → Hide Extract  

 In Filter section 
 
1.  ‘General’ tab → Under ‘Activity’→  select ‘Active (3x in 2yrs)’* → or ‘Patient Status’ tab → tick ‘Registered with 

MyMedicare’

 
 

2. MBS Attendance → MBS item categories → select RACF 

 
 

3. Date Range (results) → e.g.  select 12mths  
NOTE:  Western Sydney HealthPathways Immunisation for vaccine schedule recommendations

 
 

 
4. Recalculate   

 
 In Report section 

 
5. “Immunisations” tab → select Influenza or Pneumococcal At Risk or COVID 19 

 

Select ‘Not Recorded’ → Export →   XLS File → Save  
(e.g. Create a folder C:/ClinicalAudit/CAT Patient FollowUp) 

6. Optional: Create a prompt to display in Topbar  
 

7. Optional: Optional: Use the Measuring Outcomes table to track progress and support self-reflection over time.. 

  

Activity goal The aim of this activity is identify residents of Residential Aged Care Homes 
eligible for vaccination. 

QI lead & team members Who will need to be involved? 
Start date  Start date End date  end date 

An alternative way to flag RACH patients is by using the RACH address—sort the vaccination report by address 
in Excel to easily identify and group these patients. Need help? Contact support@wentwest.com.au.  

https://help.pencs.com.au/display/CG/Navigating+CAT4
https://help.pencs.com.au/display/CG/MBS+Attendance+Filter
https://westernsydney.communityhealthpathways.org/44304.htm
https://westernsydney.communityhealthpathways.org/44304.htm
https://help.pencs.com.au/display/CR/Using+Topbar+Prompts+in+Recipes
mailto:support@wentwest.com.au
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1.5 Activity – Culturally & Linguistically Diverse patients 

 
CAT4 recipe:  

Complete the below table by logging into Pen CS CAT4  → Show Extracts → load latest data extract → Hide Extract  

 In Filter section 
 
3.  ‘General’ tab → Under ‘Activity’→  select ‘Active (3x in 2yrs)’* → or ‘Patient Status’ tab → tick ‘Registered with 

MyMedicare’ 

 
 

4. Ethnicity → tick box for other ethnicities than Australian.   

 
 

5. Date Range (results) → e.g.  select 12mths  
NOTE:  Western Sydney HealthPathways Immunisation for vaccine schedule recommendations

 
 

 
6. Recalculate  

 
 In Report section 

7. “Immunisations” tab → select Influenza or Pneumococcal At Risk or COVID 19 

Select ‘Not Recorded’ → Export →   XLS File → Save  
(e.g. Create a folder C:/ClinicalAudit/CAT Patient FollowUp) 

8. Optional: Create a prompt to display in Topbar  
 

9. Optional: Optional: Use the Measuring Outcomes table to track progress and support self-reflection over time. 

  

Activity goal The aim of this activity is identify patients with Culturally & Linguistically Diverse 
(CALD) patients eligible for vaccination. 

QI lead & team members Who will need to be involved? 
Start date  Start date End date  end date 

https://help.pencs.com.au/display/CG/Navigating+CAT4
https://help.pencs.com.au/display/CG/Ethnicity+Filtering
https://westernsydney.communityhealthpathways.org/44304.htm
https://westernsydney.communityhealthpathways.org/44304.htm
https://help.pencs.com.au/display/CR/Using+Topbar+Prompts+in+Recipes
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1.1 Activity – People with Chronic Conditions 

 
Refer to Practice Incentive Program Measures or filter by other conditions 

• PIPQI Measure 5 – Influenza immunisation for patients with diabetes 
• PIPQI Measure 6 – Influenza immunisation for patients with COPD 

 
CAT4 Recipe:  
 
Complete the table below by logging into Pen CS CAT4  → Show Extracts → load latest data extract → Hide Extract  

 In Filter section 

 
1. Under ‘General’ tab → ‘Activity’ tab→ select ‘Active (3x in 2yrs)’ OR ‘Patient Status’ tab → tick ‘Registered with 

MyMedicare’ 

 
2. Under ‘General’ tab → Age → Start Age "65" 

 

3.  (optional filtering):  
 Under ‘General’ tab → ‘Ethnicity’ tab → Indigenous Status → select ‘Non-Indigenous’ under  

 

4. Date Range (results) → e.g.  select 12mths –  

NOTE:  Western Sydney HealthPathways Immunisation for vaccine schedule recommendations 

 
 
 

5. Recalculate  

  

Activity goal The aim of this activity is identify people chronic conditions  e.g., asthma, diabetes, 
heart disease eligible for vaccination. 

QI lead & team 
members      Who will need to be involved? 

Start date  Start date End date  end date 

https://help.pencs.com.au/pages/viewpage.action?pageId=47317125
https://help.pencs.com.au/pages/viewpage.action?pageId=47317135
https://help.pencs.com.au/display/CG/Navigating+CAT4
https://help.pencs.com.au/pages/viewpage.action?pageId=47317113
https://help.pencs.com.au/display/CG/Ethnicity+Filtering
https://westernsydney.communityhealthpathways.org/44304.htm
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  In Report section 
6. 'Disease'  → 'Count'  → select on “Diabetes Type II, Diabetes Type I, Undefined Diabetes, Asthma, COPD, CHD, Heart 

Failure, Hypertension, Stroke, Inflammatory Arthritis, Renal Impairment, Atrial Fibrillation" segments of the graph. 
Any combination of chronic conditions can be selected, this will show all patients with at least one of the selected 
conditions  

 
 
7. “Immunisations” tab → select Influenza or Pneumococcal At Risk or COVID 19 

 

Select ‘Not Recorded’ → Export →   XLS File → Save  
(e.g. Create a folder C:/ClinicalAudit/CAT Patient FollowUp) 
 

10. Optional: Create a prompt to display in Topbar  
 

11. Optional: Use the Measuring Outcomes table to track progress and support self-reflection over time. 

 

 
Use the immunisation period as an opportunity to enrol patients with chronic conditions into MyMedicare 

https://help.pencs.com.au/display/CR/Using+Topbar+Prompts+in+Recipes
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Module 1: Measuring Outcomes 
Run a CAT4 search to establish a baseline measure and at each report date to track progress over time. 

Active* people aged 65 years and over with 
Baseline Report 1 Report 2 Report 3 

date date date date 

Current Year - COVID-19 vaccination     

Current Year - Influenza vaccination     

Current Year - Pneumococcal vaccination     

Active* Indigenous patients with 
Baseline Report 1 Report 2 Report 3 

date date date date 

Current Year - COVID-19 vaccination     

Current Year - Influenza vaccination     

Current Year - Pneumococcal vaccination     

Active* patients with immunocompromised condition/s 
Baseline Report 1 Report 2 Report 3 

date date date date 

Current Year - COVID-19 vaccination     

Current Year - Influenza vaccination     

Current Year - pneumococcal vaccination     

Active* RACH Residences with 
Baseline Report 1 Report 2 Report 3 

date date date date 

Current Year - COVID-19 vaccination     

Current Year - Influenza vaccination     

Current Year - Pneumococcal vaccination     

Active* CALD patients with 
Baseline Report 1 Report 2 Report 3 

date date date date 

Current Year - COVID-19 vaccination     

Current Year - Influenza vaccination     

Current Year - Pneumococcal vaccination     

Active* Patient with Chronic Condition “Diabetes”  
Baseline Report 1 Report 2 Report 3 

date date date date 

Current Year - COVID-19 vaccination     

Current Year - Influenza vaccination     

Current Year - Pneumococcal vaccination     
* Per RACGP, an active patient has 3+ visits in 2 years. This filter may exclude new or at-risk patients who don't see their GP regularly 

 

  

Measuring Outcome CPD Tip:  Collaborate as a team to generate a CAT4 list of patients per GP.  

http://help.pencs.com.au/display/CR/Identify%2Bpatients%2Bseen%2Bby%2Ba%2Bparticular%2Bprovider%2Bor%2Bgroup%2Bof%2Bproviders
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Module 1: Group reflection after completing activities 

 

As a team, analysis and review baseline data results and discuss change ideas and actions.  
Use PDSA cycles to test and measure change ideas 
 

The degree to which the learning needs were met: 
  Not met 
  Partially met 
  Entirely met 

 

To what degree this activity was relevant to your practice: 
 Not met 
 Partially met 
 Entirely met 

 

What did you learn?  What changes would you make to your practise as a result? 

For example, based on your CAT4 database search was your practice’s results: 
 higher than you expected  
 about what you expected 
 lower than you expected 

 
RACGP CPD: utilise the self-reporting feature on Quick Log mycpd.racgp.org.au to document reflection. 
 

 

 

  

https://mycpd.racgp.org.au/log
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The clinical team can use AIR to check a patient’s immunisation status before initiating recalls. 

Generate a patient list with contact details, update records in the GP Clinical Desktop System (CDS), 

call patients for updates, or create a mail merge for recalls/reminder.   

The Practice Nurse can then action the recall list to ensure vaccines are administered. 

Module 2 
 

Australian Immunisation Register (AIR 
 

On completion of this module, you will: 
• View & update AIR immunisation history (marked as "not given here" if recorded externally). 

• Update patient details: additional vaccines, Indigenous status, schedule catch-ups. 

 

The Australian Immunisation Register (AIR) is an online national register which records vaccines given to all 
people in Australia. This includes vaccines that are under the National Immunisation Program (NIP), COVID-19 
vaccines, and vaccines that are given privately.  

The AIR can only accept immunisation information from recognised vaccination providers in Australia, such as 
GPs, midwives and nurse practitioners. The AIR cannot accept any information from parents, guardians or 
individuals. 

Recognised vaccination providers can use the AIR to: 

• record patient immunisation information 

• update or correct data already sent to the AIR 

• request reports to help identify any patients due or overdue for a vaccination 

• report immunisation medical exemptions online (if eligible) 

• get information payments for the provision of certain vaccinations (if eligible) 

• find out a patient’s immunisation status, regardless of who immunised them 

• print an immunisation history statement to prove a patient’s immunisation status for child care, school, 

employment or travel purposes. 

 

Learn how to use AIR via Department of Human Services AIR 
eLearning modules 

 

 

 

  

Subscribe to NCIRS weekly 
series of AIR tips and updates 

https://www.servicesaustralia.gov.au/individuals/services/medicare/australian-immunisation-register
https://www.servicesaustralia.gov.au/how-to-record-encounter-using-air-site-through-hpos?context=23401
https://www.servicesaustralia.gov.au/how-to-update-encounter-using-air-site-through-hpos?context=23401
https://www.servicesaustralia.gov.au/how-to-view-and-print-reports-and-statements-using-air-site-through-hpos?context=23401
https://www.servicesaustralia.gov.au/immunisation-medical-exemptions-for-health-professionals?context=23401
https://www.servicesaustralia.gov.au/vaccination-provider-information-payments-for-health-professionals?context=23401
https://www.servicesaustralia.gov.au/how-to-view-patient-details-air-site-using-hpos?context=23401
https://www.servicesaustralia.gov.au/how-to-download-and-print-immunisation-history-statement-using-air-site-through-hpos?context=23401
https://hpe.servicesaustralia.gov.au/AIR_access.html
https://hpe.servicesaustralia.gov.au/AIR_access.html
https://ncirs.org.au/air-tips
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2.1 Activity – Accessing the AIR as delegate via PRODA /HPOS 

 
 

To access the AIR as a delegate of a recognised vaccination provider** (such as 
a GP, midwife or nurse practitioner) you need to register an individual PRODA 
account and Registration Authority (RA) number. 

After you have set up your individual PRODA account, use the following 
instructions to link AIR into PRODA/HPOS and submit a delegation request in 
HPOS (for provider to approve). For more information, access NCIRS guide for 
supporting and understanding delegations in HPOS to enable access to AIR  

 

How to access the AIR as a delegate 
After your delegation request has been approved by the provider, follow the steps below to access the AIR: 

1. Log on to your PRODA individual account 
2. Under My Linked Services the HPOS tile will display 
3. Click on Go to Service on the tile to access HPOS 
4. Click on No Organisation – Proceed as an individual 

only, then Continue 
5. From the My providers table, select in the action 

column for the relevant provider 
6. Select My programs 
7. Click on the Australian Immunisation Register (AIR) 

tile 

 
 

Identifying patient details 
1. To search for your patient, on the left-hand menu, select ‘Identify Individual’. 

• If the patient is eligible for Medicare, you can find the patient’s AIR record by entering their Medicare number 
or Individual Reference Number (IRN). 

• If the patient is not eligible for Medicare, look them up by entering their surname, first name and date of birth. 
2. If the AIR finds a unique match, the ‘Individual details’ page will display their immunisation details. 

 

**Finding Your AIR Provider Number 

• If your practice administered COVID-19 vaccines, you may already have an AIR provider number. 
• To check: Log into PRODA → Medicare → Organisation → HPOS - AIR Provider Number. 
• If missing, submit IM004 application to your state/territory health department. If unsure contact the AIR on 1800 

653 809.  

Activity goal Improve the process of healthcare providers accessing AIR and submitting 
delegation requests in Health Professional Online Services (HPOS). 

QI lead & team members Who will need to be involved? 
Start date  Start date End date  end date 

When registering an 
individual PRODA account, 

use your personal (non-work 
related) email address to 
ensure you will be able to 

     

Important note:  
To enable access to the AIR functions, make sure to select 
My programs when requesting your delegation functions. 

https://proda.humanservices.gov.au/pia/pages/public/registration/account/createAccount.jsf
https://proda.humanservices.gov.au/pia/pages/public/registration/account/createAccount.jsf
https://proda.humanservices.gov.au/pia/pages/public/registration/account/createAccount.jsf
https://www.servicesaustralia.gov.au/set-up-air-access-for-your-practice-organisation-or-authorised-nurse-immuniser?context=23401&%3A%7E%3Atext=Set%20up%20AIR%20access%20for%20your%20practice%2C%20organisation%2Cadd%20members%20to%20your%20organisation%20PRODA%20account%20
https://www.ncirs.org.au/sites/default/files/2020-12/HPOS%20-%20Supporting%20providers_December%202020_Final_0.pdf
https://www.servicesaustralia.gov.au/proda-provider-digital-access#a2
https://www.servicesaustralia.gov.au/hpos
https://proda.humanservices.gov.au/prodalogin/pages/public/login.jsf?TAM_OP=login&ERROR_CODE=0x00000000&URL=%2F&OLDSESSION
https://www.servicesaustralia.gov.au/im004
https://www.humanservices.gov.au/organisations/health-professionals/enablers/accessing-air-using-hpos
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2.2 Activity – Accessing the AIR via Practice Management Software  

 

 

Access to AIR via Best Practice 

1. Search for the patient’s record: Press F2 on the home screen and enter the patient’s details 
2. On the left-hand side of the page, click on the Immunisation tab 
3. Then click on ‘View AIR’ 

 
4. The report will then appear with the patient’s immunisation history 

 
For more information, visit Best Practice Knowledge Base to learn how to access and update AIR patient profiles including 
downloading records, viewing alerts, and updating vaccines, Indigenous status, and catch-ups.  

Activity goal  
Enhance immunisation processes by ensuring seamless access to AIR data 
through direct linkage with Best Practice and Medical Director.  
 

QI lead & team members Who will need to be involved? 
Start date  Start date End date  end date 

Ensure all users have the appropriate AIR Provider Number and verify existing numbers using provided 
instructions in Activity 2.1 to maintain smooth data submission and access. 

https://kb.bpsoftware.net/bppremier/saffron/Clinical/Immunisations/ViewAIR.htm?Highlight=immunisation%20history
https://kb.bpsoftware.net/bppremier/saffron/GettingStarted/SetupPracticeDetails.htm?step=4
https://www.medicaldirector.com/help/topics-clinical/Immunisations.htm
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Access to AIR via Medical Director 

1. Search for the patient’s record 
2. Click on the ‘Imm’ tab 
3. Then select ‘Immunisation History’ 
4. The patient’s immunisation history will show at the bottom of the screen 

 

 Conduct a live patient verification check with AIR. 

 Click to record a medical exemption for the given patient. 

 Click to record a planned catch up for the given patient. 

 Click to download the patient's immunisation statement from AIR. 

 

For more information, visit Medical Director Knowledge Base to learn how to access and update AIR patient profiles 
including downloading records, viewing alerts, and updating vaccines, Indigenous status, and catch-ups. 

  

https://www.medicaldirector.com/help/topics-clinical/Immunisations.htm#Medical_Exemptions
https://www.medicaldirector.com/help/topics-clinical/Immunisations.htm#Planned_Catch_Ups
https://www.medicaldirector.com/help/topics-clinical/Immunisations.htm?rhhlterm=AIR%20&rhsyns=%20
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2.3 Activity – AIR reports  

 

The Australian Immunisation Register (AIR) offers several reports to help your practice identify patients who are due or 
overdue for immunisations, as well as to support broader patient data management needs. These reports provide valuable 
insights, including: 

• Individuals’ immunisation history and upcoming or overdue vaccine dates 

• Lists of patients by age group 

• Identification of incorrectly recorded information 

Reports can be downloaded and saved for offline use, with output formats that can be customised to suit your practice’s 
needs. You can also schedule reports to run regularly (e.g., weekly) and enable email notifications to alert you when your 
reports are ready to access on the AIR site. 

 

Resources Available 
Services Australia has a suit of infographics on the Health Professional Education portal to support health professionals in 
using AIR. These resources provide guidance on how to: 

• delete a vaccination from the AIR  
• access and use AIR reports  
• check the accuracy of immunisation encounters before reporting to the AIR  

 

Getting Started 
Decide which report best meets your needs. For winter 
preparedness, we recommend the following: 

• AIR042A COVID-19 and Influenza Immunisation 
Report 

• AIR010A Immunisation History Report 

Once requested, your AIR report will be available for download via 
the View tab under the Reports menu in AIR. 

 

Additional Information 

• Services Australia AIR010A User Guide 

• AIR eLearning Module 

 
   

 

  

Activity goal Use AIR reports to identify patients due or overdue for immunisations, track 
immunisation history, organise patients by age group, and detect incorrectly 
recorded information. 

QI lead & team members Who will need to be involved? 
Start date  Start date End date  end date 

https://www.servicesaustralia.gov.au/how-to-view-identified-reports-using-air-site-through-hpos?context=23401
https://ncirs.createsend1.com/t/t-l-skuiklt-exhthrc-yk/
https://ncirs.createsend1.com/t/t-l-skuiklt-exhthrc-w/
https://ncirs.createsend1.com/t/t-l-skuiklt-exhthrc-yd/
https://ncirs.createsend1.com/t/t-l-skuiklt-exhthrc-yd/
https://ncirs.createsend1.com/t/t-l-skuiklt-exhthrc-yd/
https://ncirs.createsend1.com/t/t-l-skuiklt-exhthrc-yh/
https://hpe.servicesaustralia.gov.au/MODULES/AIR/AIRM12/index.html
https://hpe.servicesaustralia.gov.au/MODULES/AIR/AIRM12/index.html
https://www.servicesaustralia.gov.au/how-to-view-identified-reports-using-air-site-through-hpos?context=23401
https://cesphn.org.au/wp-content/uploads/2024/07/AIR-010A-Report-User-Guide-Nov-2020-V1.0-3.pdf
https://hpe.servicesaustralia.gov.au/AIR_access.html
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2.4 Activity – Updating Patient Record  

 

Visit Services Australia for a comprehensive guide on recording and updating an encounter in the Australian Immunisation 
Register (AIR). If the immunisation was not administered at your practice it is still important that it is entered into the clinical 
software to ensure an accurate health summary. 

Best Practice: Updating Patient’s Immunisation Record  

1. In Immunisation section 
2. Select ‘Add’ 
3. Choose the correct vaccine from the list provided 
4. Under ‘Billing Provider’, select ‘Not given here’ from the drop-down list 
5. Enter the date that appears on the report from the AIR 
6. Set when to ‘Send Reminder’ 
7. DO NOT select the ‘Send to AIR’ box 
8. Select ‘Save’ 
9. You will now be able to identify which vaccinations your patient has not received. 

 

 
 
Activity goal 

 
Update patient vaccination records by cross-checking the immunisation report 
with Best Practice and Medical Director  
 

QI lead & team members Who will need to be involved? 
Start date  Start date End date  end date 

1. 

2. 

3. 

4. 

5. 

7. 8.  

6. 

https://www.servicesaustralia.gov.au/how-to-record-encounter-using-air-site-through-hpos?context=23401
https://kb.bpsoftware.net/bppremier/saffron/GettingStarted/SetupPracticeDetails.htm?step=4
https://www.medicaldirector.com/help/topics-clinical/Immunisations.htm
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Best Practice:  immunisation infographic summarising process for: recording immunisations, adding a non-listed injection, 
running an immunisation query search, and how to view and save patient AIR records into Best Practice. 

 

 

 

 

  

https://kb.bpsoftware.net/docs/BpPremier_QRG_RecordImmunisations.pdf
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Medical Director: Updating Patient’s Immunisation Record  

1. On the main screen of the patients file, click on ‘Imm’  

2. To add an immunisation, click on the  

3. If you have identified that the vaccination was provided elsewhere, click on the box ‘Vaccine given elsewhere’ 

4. Complete the details from AIR in the ‘Vaccination Window’, then select ‘Save’ 

 

 

Module 2: Group reflection after completing activities: 

 

As a team, analysis and review baseline data results and discuss change ideas and actions.  
Use PDSA cycles to test and measure change ideas 
 

The degree to which the learning needs were met: 
  Not met 
  Partially met 
  Entirely met 

 

To what degree this activity was relevant to your practice: 
 Not met 
 Partially met 
 Entirely met 

 

What did you learn?  What changes would you make to your practise as a result? 

For example, based on your CAT4 database search was your practice’s results: 
 higher than you expected  
 about what you expected 
 lower than you expected 

RACGP CPD: utilise the self-reporting feature on Quick Log mycpd.racgp.org.au to document reflection. 
 

Check individual My Health Record or request AIR report or your practice patients immunisation status.  

https://mycpd.racgp.org.au/log
https://www.digitalhealth.gov.au/healthcare-providers/initiatives-and-programs/my-health-record#education-and-training
https://aus01.safelinks.protection.outlook.com/?url=https%3A%2F%2Fwww.servicesaustralia.gov.au%2Fview-vaccination-provider-reports%3Fcontext%3D20%23all-accordions&data=05%7C02%7Cmaha.sedhom%40wentwest.com.au%7C5a1db6acd6ed44584aae08dd042a6e9a%7C90dec9afb3c84c3989d2e24c4a9104d3%7C1%7C0%7C638671302479676543%7CUnknown%7CTWFpbGZsb3d8eyJFbXB0eU1hcGkiOnRydWUsIlYiOiIwLjAuMDAwMCIsIlAiOiJXaW4zMiIsIkFOIjoiTWFpbCIsIldUIjoyfQ%3D%3D%7C0%7C%7C%7C&sdata=45QGoBp9hOu%2BjBGiP2w%2F%2BGiu9DlA6LT15k2NyQ5fcME%3D&reserved=0
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Module 3 
 

Patient Engagement 
 

On completion of this module, you will: 

• Improve Patient Engagement: Enhance communication strategies to boost patient participation in vaccination 
programs. 

• Optimise Recalls and Reminders: Develop effective systems for timely vaccination reminders. 
• Create Effective Patient Resources: Design resources that educate and encourage vaccination. 
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3.1 Activity – Patient Engagement 

 
Patient Resources 

Western Sydney’s diverse community, with many residents born overseas and a significant First Nations population, faces 
higher risks from vaccine-preventable diseases. Providing translated and culturally appropriate resources is essential to 
support COVID-19, flu, and pneumococcal vaccination and keep our community protected. 

Below are key Australian and NSW resources for patient education tailored to different population groups: 

COVID-19  Influenza Vaccination  

• COVID vaccination Information 
• COVID vaccination Community Resources 
• COVID vaccination Booster Dose Poster  
• COVID vaccination easy read resources  
• COVID vaccination Translated Resources 
• COVID vaccination First Nations Resources  
• COVID vaccination AUSLAN Videos  

 

• Flu vaccination Community Resources 
• Flu vaccination – Consumer fact sheet 
• Flu vaccination Translated Resources 
• Flu vaccination First Nations Resources 
• Order Flu vaccination Resources (Print) 

 

Pneumococcal  All Vaccines 

• Pneumococcal Community Resources 
• Pneumococcal First Nations Resources 

• WentWest Winter Preparedness Poster 
• Commonwealth Immunisation Resources 
• NSW Health Immunisation Resources 
• NSW Health Order Printed resources 
• Indigenous HealthInfoNet Immunisation 

Resources 

 
Practical Steps to Prepare Your Practice 

• Send communications to all patients from March–April onwards, highlighting the importance of COVID-19, 

Influenza, and Pneumococcal vaccinations. 

• Send targeted SMS reminders to high-risk patients about vaccination arrangements and follow up with those who 

have not yet attended. 

• Display multilingual posters and digital materials in waiting areas and consultation rooms to promote vaccine 

awareness. 

• Provide credible, easy-to-understand resources that debunk common myths and support informed decision-

making 

• Host vaccine Q&A sessions or group education forums with clinicians to address patient concerns, increase 

engagement, and encourage open dialogue. 

• Encourage trusted voices, such as GPs and community leaders, to advocate for vaccination and build confidence. 

• Offer personalised, culturally sensitive conversations with hesitant patients to address individual concerns and 

health beliefs. 

  

Activity aim Enhance patient education and engagement regarding COVID-19, Influenza, and 
Pneumococcal vaccinations, with a focus on high-risk groups and vaccine hesitancy. 

QI lead & team members Who will need to be involved? 
Start date  Start date End date  end date 

https://www.health.gov.au/initiatives-and-programs/covid-19-vaccines
https://www.health.nsw.gov.au/Infectious/covid-19/Pages/resources.aspx
https://www.health.nsw.gov.au/Infectious/covid-19/vaccine/Documents/booster-poster-healthcare-workers.pdf
https://www.health.gov.au/resources/collections/covid-19-vaccination-easy-read-resources
https://www.health.nsw.gov.au/Infectious/covid-19/Pages/multilingual.aspx
https://www.health.nsw.gov.au/Infectious/covid-19/Pages/aboriginal-resources.aspx#winter
https://www.health.gov.au/resources/collections/covid-19-vaccination-videos-auslan
https://www.health.nsw.gov.au/Infectious/respiratory/Pages/resources.aspx
https://www.health.gov.au/resources/publications/2025-influenza-flu-vaccination-consumer-fact-sheet?language=en
https://www.health.nsw.gov.au/Infectious/respiratory/Pages/translations.aspx
https://www.health.nsw.gov.au/Infectious/respiratory/Pages/aboriginal-resources.aspx
chrome-extension://efaidnbmnnnibpcajpcglclefindmkaj/https:/www.health.nsw.gov.au/Infectious/Influenza/Documents/influenza-publications-order-form.pdf
https://immunisationhandbook.health.gov.au/resources/publications/pneumococcal-vaccination-for-all-australians
https://www.health.gov.au/topics/immunisation/when-to-get-vaccinated/immunisation-for-aboriginal-and-torres-strait-islander-people
https://wentwest.com.au/wp-content/uploads/2025/03/WW-WinterPreparedness_A3-Poster_PRINT-1.pdf
https://www.health.gov.au/topics/immunisation/immunisation-resources
https://www.health.nsw.gov.au/immunisation/Pages/immunisation-brochures.aspx
chrome-extension://efaidnbmnnnibpcajpcglclefindmkaj/https:/www.health.nsw.gov.au/immunisation/Documents/resource-order-form.pdf
https://healthinfonet.ecu.edu.au/learn/determinants-of-health/health-behaviours/immunisation/resources/
https://healthinfonet.ecu.edu.au/learn/determinants-of-health/health-behaviours/immunisation/resources/
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3.2 Activity – Reminders and Patient Education 

 
 

RACGP standards require preventive care and tailored reminders, including for patients with limited English. Use your 
software to identify and remind patients due for vaccines. 

 

 Software Adding reminders Create mail merges  Create bulk SM Adding notes 

Best Practice Add a Clinical Reminder to 
a patient 

Send Health 
Awareness 
Communications  

Send clinical 
reminders  

Add and review 
contact notes 

Medical Director 
Recall, Reminders, 
Actions and Outstanding 
Requests  

Mail merge  

Sending SMS 
reminders  

Editing a patient’s 
details from within 
their record 

 
Training: Free online modules at Train IT, Code: WSPHN-2023 

 

  

Activity aim Develop and apply systems for patient recalls and reminders to enhance follow-up care and 
continuity in COVID-19, Influenza, and Pneumococcal vaccination management. 

QI lead & team 
members 

Who will need to be involved? 

Start date  Start date End date  end date 

 
GoShare is a patient education platform enabling health professionals to send 
tailored, trusted resources—such as videos and fact sheets—via email or SMS to 
help patients manage their health, improve health literacy, and boost 
engagement.  

FREE GoShare Recall Campaigns 

Pneumococcal – Read Practice Brief and complete expression of interest 
form  
COVID - Read Practice Brief and complete expression of interest form 

WentWest has funded GoShare subscriptions for all general practices in 
Western Sydney.  

For access, please contact us at support@wentwest.com.au 

 

GoShare 
patient 
education 
platform 

 Access 
 

SMS Message Tips: Keep it clear, professional, and actionable. 
Example: Hello [Patient Name], you’re due for your [vaccine] at [Practice Name]. Book online or call [Phone #] 

 

https://www.racgp.org.au/running-a-practice/practice-standards/standards-5th-edition/standards-for-general-practices-5th-ed/general-practice-standards/gp-standard-2/criterion-gp2-2-follow-up-systems
https://kb.bpsoftware.net/bppremier/Orchid/Clinical/Reminders/AddRemindertoPatient.htm?Highlight=adding%20reminder
https://kb.bpsoftware.net/bppremier/Orchid/Clinical/Reminders/AddRemindertoPatient.htm?Highlight=adding%20reminder
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/SendHealthAwareness.htm?Highlight=send%20health%20awareness
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/SendHealthAwareness.htm?Highlight=send%20health%20awareness
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/SendHealthAwareness.htm?Highlight=send%20health%20awareness
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/SendClinicalReminders.htm?Highlight=Send%20clinical%20reminders
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/SendClinicalReminders.htm?Highlight=Send%20clinical%20reminders
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/AddReviewContactNotes.htm?Highlight=Add%20and%20review%20contact%20notes
https://kb.bpsoftware.net/bppremier/Orchid/BpComms/AddReviewContactNotes.htm?Highlight=Add%20and%20review%20contact%20notes
https://www.medicaldirector.com/help/index.htm#t=kba%2Fclinical%2FRecalls%2C_Reminders%2C_Actions%2C_and_Outstanding_Requests_-_Fact_Sheet.htm&rhsearch=recalls&rhhlterm=recalls&rhsyns=%20
https://www.medicaldirector.com/help/index.htm#t=kba%2Fclinical%2FRecalls%2C_Reminders%2C_Actions%2C_and_Outstanding_Requests_-_Fact_Sheet.htm&rhsearch=recalls&rhhlterm=recalls&rhsyns=%20
https://www.medicaldirector.com/help/index.htm#t=kba%2Fclinical%2FRecalls%2C_Reminders%2C_Actions%2C_and_Outstanding_Requests_-_Fact_Sheet.htm&rhsearch=recalls&rhhlterm=recalls&rhsyns=%20
https://www.medicaldirector.com/help/#t=topics-clinical%2FMail_Merge.htm&rhsearch=mail%20merge&rhsyns=%20&rhhlterm=mail%20merge
https://www.medicaldirector.com/help/#t=topics-clinical%2FSending_SMS_Reminders.htm&rhsearch=sms&rhsyns=%20
https://www.medicaldirector.com/help/#t=topics-clinical%2FSending_SMS_Reminders.htm&rhsearch=sms&rhsyns=%20
https://www.medicaldirector.com/help/#t=topics-clinical%2FEditing_a_Patient_s_Details_from_the_Clinical_Window.htm&rhsearch=patient%20details&rhsyns=%20
https://www.medicaldirector.com/help/#t=topics-clinical%2FEditing_a_Patient_s_Details_from_the_Clinical_Window.htm&rhsearch=patient%20details&rhsyns=%20
https://www.medicaldirector.com/help/#t=topics-clinical%2FEditing_a_Patient_s_Details_from_the_Clinical_Window.htm&rhsearch=patient%20details&rhsyns=%20
https://courses.trainitmedical.com.au/
https://kb.healthily.com.au/knowledgebase/what-is-goshare/
https://kb.healthily.com.au/knowledgebase/patient-engagement-tips/
https://kb.healthily.com.au/knowledgebase/patient-engagement-tips/
https://wentwest.com.au/wp-content/uploads/2025/03/PCV13-PRP-Practice-Brief-FINAL-2025.pdf
https://aus01.safelinks.protection.outlook.com/?url=https%3A%2F%2Fforms.gle%2FfovE1wfRG8Gr268cA&data=05%7C02%7Cmaha.sedhom%40wentwest.com.au%7C7c52b766ed434bd3525e08dd650399c3%7C90dec9afb3c84c3989d2e24c4a9104d3%7C1%7C0%7C638777788359011850%7CUnknown%7CTWFpbGZsb3d8eyJFbXB0eU1hcGkiOnRydWUsIlYiOiIwLjAuMDAwMCIsIlAiOiJXaW4zMiIsIkFOIjoiTWFpbCIsIldUIjoyfQ%3D%3D%7C0%7C%7C%7C&sdata=E48stW0fvCjaqMmiqhOOTlaFipo1LbFOT4a8O%2FBCF9k%3D&reserved=0
https://aus01.safelinks.protection.outlook.com/?url=https%3A%2F%2Fforms.gle%2FfovE1wfRG8Gr268cA&data=05%7C02%7Cmaha.sedhom%40wentwest.com.au%7C7c52b766ed434bd3525e08dd650399c3%7C90dec9afb3c84c3989d2e24c4a9104d3%7C1%7C0%7C638777788359011850%7CUnknown%7CTWFpbGZsb3d8eyJFbXB0eU1hcGkiOnRydWUsIlYiOiIwLjAuMDAwMCIsIlAiOiJXaW4zMiIsIkFOIjoiTWFpbCIsIldUIjoyfQ%3D%3D%7C0%7C%7C%7C&sdata=E48stW0fvCjaqMmiqhOOTlaFipo1LbFOT4a8O%2FBCF9k%3D&reserved=0
https://wentwest.com.au/wp-content/uploads/2025/03/COVID-19-Vaccination-Practice-Brief_2025.pdf
https://docs.google.com/forms/d/e/1FAIpQLSeN7D1J_TnFkwPyWV6NWQYF-Qbrwv1wOsYhnKTOx7oARwxTYw/viewform
mailto:support@wentwest.com.au
https://kb.healthily.com.au/knowledgebase/what-is-goshare/
https://kb.healthily.com.au/knowledgebase/what-is-goshare/
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Module 3: Group reflection after completing activities: 

 

As a team, analysis and review baseline data results and discuss change ideas and actions.  
Use PDSA cycles to test and measure change ideas 
 

The degree to which the learning needs were met: 
  Not met 
  Partially met 
  Entirely met 

 

To what degree this activity was relevant to your practice: 
 Not met 
 Partially met 
 Entirely met 

 

What did you learn?  What changes would you make to your practise as a result? 

For example,  
• Has patient engagement increased through education efforts? 
• Which educational strategies were most effective? 
• Have vaccination rates improved following outreach efforts? 
• Do relevant team members know how to send out GoShare patient resources, videos and apps? 
• What barriers were encountered in patient engagement? 

 

RACGP CPD: utilise the self-reporting feature on Quick Log mycpd.racgp.org.au to document reflection. 

 

 

  

https://mycpd.racgp.org.au/log
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Appendices 
 

Model for Improvement 

Step 1: Thinking Part - Three Fundamental Questions (complete the Model for Improvement (MFI) as a whole team) 

1. GOAL What are we trying to accomplish?  

By answering this question, you will develop your GOAL for improvement. It important to establish a S.M.A.R.T (Specific, 
Measurable, Achievable, Relevant, Time bound) goal and people-crafted aim that clearly states what you are trying to 
achieve. 

Increase <pneumococcal> vaccination recall for <00>patients adults aged <70–80> in the next 3 month (winter 
period)  

2. MEASURE How will we know that a change is an improvement?   

By answering this question, you will develop the MEASURE(S) you will use to track your overarching goal. Record and track 
your baseline measurement to allow for later comparison.  

• Number of overdue patients   
• Number of administered vaccines 
• Number of eligible patient cohort  

Baseline: <34> overdue patients   Baseline 
date: 19/03/2025 

3. IDEAS What changes can we make that will result in improvement? 

By answering this question, you will develop IDEAS for change.  Tip: Engage the whole team in formulating change ideas. 
Include any predictions and measure their effect quickly.  

Idea 1 
Using data extracted from the Australian Immunisation Register (AIR), a report will be generated 
listing patients overdue for the <Prevenar13> vaccine. These patients will be contacted and offered 
the vaccine. 

Idea 2 
Use GoShare <Or recall system> recall patients aged <70 to 80> who have not yet received their 
<pneumococcal> vaccination and monitor vaccination rate through a 30 days and 60 days progress 
report. 

Idea 3  

Idea 4       

Idea 5       

Next step: Each idea may involve multiple short and small PDSA cycles. 

For quality improvement support, contact WentWest at support@wentwest.com.au. 

mailto:support@wentwest.com.au
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PDSA (Plan-Do-Study-Act) 

Step 2: Doing Part - Plan-Do-Study-Act (Once you have completed the Model for Improvement (MFI), use this template to 
document and track your PDSA cycles) 

Idea Plan Do Study Act 

# Plan the test Prediction Do the test  
on small scale 

Analyse  
the results 

Make a plan 
 for next step 

 
How will we run this test? 
Who will do it and when? 
What will we measure? 

Prediction or 
hypothesis on 
what will 
happen. 

Was the plan 
completed? Yes or 
No. Collect data. 
Consider what 
worked well and 
why? Document any 
unexpected 
observations, events 
or problems. 

Analyse results, 
compare them to 
predictions, and 
reflect on what 
you learned. . 

Based on your 
learnings from the 
test, what will you do 
next (e.g., adopt, adapt 
or abandon)? How 
does this inform the 
plan for your next 
PDSA? 

1.1 Use GoShare <Or recall 
system> recall patients 
aged <70 to 80> who have 
not yet received their 
<pneumococcal> 
vaccination and monitor 
vaccination rate through a 
30 day progress report. 
 

Will need 
repeat recall for 
remaining 
patients who 
have not been 
vaccinated 
within this 
timeframe 

PM competed   A total of 11 
patients were 
administered 
Prevenar 13 at 30 
days 

Customise GoShare 
recall message to 
increase to 
vaccination and 
monitor progress for 
the next 30 days. 

1.2 Use GoShare <Or recall 
system> recall patients 
aged <70 to 80> who have 
not yet received their 
<pneumococcal> 
vaccination and monitor 
vaccination rate through a 
60 day progress report. 

.  A total of 21 
patients were 
administered 
Prevenar 13 at 60 
days 
 
• 2 patients 
declined vaccines 
(recorded in 
patient notes)  
• 6 patients are 
considering 
vaccination (will 
follow up in 1-2 
weeks)  
• 4 patients 
uncontactable 
(multiple 
attempts to 
contact)  
• 1 patient already 
received Prevenar 
13 (data 
uploaded to AIR)   
• 21 patients 
vaccinated   

Of the 34 patients 
overdue for 
pneumococcal 
vaccines, 21 patients 
were vaccinated, and 
1 patient had already 
received vaccine.   

 
Summary 
of results  

 



 

27 CQI Winter Preparedness Toolkit© WentWest, the Western Sydney Primary Health Network 2025 
Western Sydney Primary Health Network is operated by WentWest. 

 

WENTWEST.COM.AU 

Darug Land, 1A/160 Hawkesbury Road Westmead NSW 2145 
 
PO Box 50, Westmead NSW 2145 
 
T (02) 8811 7100 
F (02) 9622 3448 
E wentwest@wentwest.com.au 
 
www.wentwest.com.au 
 

ACN 099 255 103 
ABN 80 099 255 106 
 

WentWest the Western Sydney Primary Health Network  

 

mailto:wentwest@wentwest.com.au
http://www.wentwest.com.au/
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